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INTRODUCTION TO WORD 
Writing a Conference Call letter 

BEFORE YOU BEGIN 
Lesson 1 makes the assumption that you are already familiar with the Windows computing 

environment, though you may not be an expert in its use. If you are using a computer in a 

lab at school, you'll also know: 

• where to find the computer lab on campus; 

• how to turn the computer on; 

• how to log on to the system (using your login name and password). 

You also should be familiar with the Windows, Icons, Menus, and Pointers (the so-

called WIMP interface) with which you interact with the computer. If not, your instructor 

will make this clear to you before you proceed with these tutorials. 

Lesson 1 assumes that you have a copy of the set of work files that accompany these 

tutorials.  These files should be stored on your hard drive and/or on a USB drive. Whatever 

type of disk drive you are using, be sure it is labeled (named) appropriately. 

The work files that accompany these tutorials should be stored on the drive in three 

folders named Access Files, Miscellaneous Files and PowerPoint Files. You also will need 

a fourth folder for the data files that you will be creating while working your way through 

the tutorials. You will name this fourth folder Data Files. 

Ideally, you should have a second backup copy of the four folders mentioned above 

(Access Files, Miscellaneous Files, PowerPoint Files, and Data Files). 

If you do not have these folders and files ready, prepare them now before proceeding 

with this tutorial. Here are the steps to take: 

If necessary (if you received a zipped copy of the work files with these 
tutorials), unzip the set of Work Files for Office 365 (your instructor will 
help you with this if you are working with a class) 

Copy onto your personal space on the hard drive1 the folder titled Work 
Files for Office 365, which includes the three sets of files that accompany 
these tutorials (Access Files, Miscellaneous Files, PowerPoint Files) 

 
1 If you are working with an instructor, you will be instructed where to save your Office Tutorials files, 

perhaps on a USB drive or in a designated space on the school’s hard drive. 
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Double click on the Work Files for Office 365 folder to open it and, in 
the Work Files for Office 365 folder, click on the New group > New 
Folder (Fig. 1.0) 

 

Fig. 1.0 Creating a new folder named Data Files 

The system will create a new folder for you (highlighted in blue) and then wait for you 

to give it a name of your choice. 

Type Data Files for the name of the folder 

A caveat (warning) before you begin: You'll find it easiest to use this tutorial if you follow 

the directions carefully. On computers there are always other ways of doing things, but if 

you wander off on your own be sure you know your way back! 

 

LEARNING OUTCOMES 
Words are crucial tools of a teacher's trade. As a teacher, you owe it to yourself and to your 

students to use words well. The Office 365 word processor will help you improve your 

writing skills because it makes revision easy and thus encourages you—and your students—

to correct errors in grammar, spelling, and style. 

In this tutorial, along with some helpful hints to bear in mind when word processing, 

you will learn the steps required to produce a word-processed document from scratch and 

carry out basic formatting and editing functions. These include: 

• opening and naming a new word processor document 

• entering and saving a document 

• updating and simple formatting of a document 

• checking a document for spelling and grammar errors 

• printing a document 

• making a backup copy of a document 
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Perhaps you are not a beginner to word processing, so you may think you don't need to 

complete this tutorial. That would be a mistake. Most computer users learn no more than 

the minimum they think they need to know to use a program such as Word, without taking 

the trouble to learn other useful features of the software. 

In other words, even if you have used a word processor for a while, there's a good chance 

that you will still benefit from completing this beginner's tutorial. So, with this in mind, 

please conscientiously work your way through the tutorial with a view to learning new 

things. You'll be surprised what you’ll discover! 

 

1.1 OVERVIEW OF MICROSOFT OFFICE 365 
If you are familiar with Office 2007 or later versions of Microsoft Office, feel free to skip to 

page 11 (Section 1.2 SETTING UP AND NAMING A NEW WORD DOCUMENT). 

The Office Backstage View 

If you come to Office 365 after having previously used Office 2007, you will be happy to 

know that the Office Button (introduced in Microsoft’s Office 2007) is thankfully gone. It 

has been replaced by the restored and more familiar File menu, which, as introduced in 

Office 2010 and remained unchanged for Office 2013, 2016, 2019 and 365, gives the user a 

Backstage view on the document or file that the user is developing. 

In the Backstage view, you do things to a file (such as save it or open it or print it) that 

you do not do in the file (such as any kind of editing of the document). The Backstage View, 

if you haven’t already used it in earlier versions of Office, takes some getting used to, but 

by the time you are done with these tutorials you will be using it like a pro. 

Also, prior to Office 2007, users were limited to a traditional system of menus, toolbars, 

task panes, and dialog boxes to get their work done. In Office 365 you will continue to use 

menus and dialog boxes; but Office 365 also uses what Microsoft calls Ribbons, which have 

greatly simplified navigation of the many cool features of the various Office applications, 

including Word, Excel, Access and PowerPoint (Fig 1.1). 

 

 

Fig. 1.1 Example of a Ribbon and its Groups in the Office 365 User Interface 

Opening a new word processor document 

Click on the Start button in the lower left corner of the screen, then, from 
the All Programs menu, locate (scroll to find) the Word application 

The Home Tab, which lets you use the tools in the Home Ribbon 

The 

File Tab 

The Font Group in 

the Home Ribbon 

Paragraph, Styles, and 

Editing Groups 
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If you can find Microsoft Word by yourself, open the program now; 
otherwise get help from a friend, or your instructor, or from the lab 
supervisor 

You are now presented with the Backstage window for Word (Fig. 1.2). 

 

Fig. 1.2 Initial Word Backstage View 

Ribbons and Groups 

As you can see, you have the option to open a Blank Document (a new document), or you 

can open any one of several templates. Templates are useful because they save you having 

to create professional-looking documents, such as gift certificates and so on, from scratch. 

But for our purpose here, you want a new blank document open on your screen. 

Click once on the Blank document icon (Fig. 1.2 above) 

You should now see a blank word processor document on your screen. If you are using 

a newly installed version of Office 365, or if the version you are using does not show the 

Ribbons at the top of the page, you need to turn them on before working your way through 

the remainder of this tutorial. 
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Towards the top left of the Word window, click on the Ribbon Display 
Options icon to bring up the Ribbon Display Options menu (Fig. 1.3) 

  

Fig. 1.3 Ribbon Display Options menu 

At this stage don’t worry about all the details for each Ribbon; the many features of 

Word can be overwhelming at first. Just spend a couple of minutes clicking on each 

Ribbon’s Group names and scan the many available word processing options and actions. 

Take a look at some of the more commonly used Ribbons for Word 
365—starting with the Home Ribbon (see Fig. 1.3 above) 

Next click on the tab for the Insert Ribbon and check out the various 
Groups of tools available (Fig. 1.4) 

 

Fig. 1.4 The Groups in the Insert Ribbon 

 

Fig. 1.5 The groups in the Draw Ribbon 

Click on the tab for the Design Ribbon and check out the various Groups 
of tools available (Fig. 1.6) 

 

Fig. 1.6 The Groups in the Design Ribbon 
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Click on the tab for the Layout Ribbon and check out the various 
Groups of tools available (Fig. 1.7) 

 

Fig. 1.7 The Groups in the Layout Ribbon 

Click on the tab for the References Ribbon and check out the various 
Groups of tools available (Fig. 1.8) 

 

Fig. 1.8 The Groups in the References Ribbon 

Click on the tab for the Mailings Ribbon and check out the various 
Groups of tools available (Fig. 1.9) 

 

Fig. 1.9 The Groups in the Mailings Ribbon 

Click on the tab for the Review Ribbon and check out the various Groups 
of tools available (Fig. 1.10) 

 

Fig. 1.10 The Groups in the Review Ribbon 
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Click on the tab for the View Ribbon and check out the various Groups 
of tools available (Fig. 1.11) 

 

Fig. 1.11 The Groups in the View Ribbon 

Finally, click on the tab for the Help Ribbon and check out the various 
Groups of tools available there (Fig. 1.12) 

 

Fig. 1.12 The Groups in the View Ribbon 

Thus, a Ribbon is a strip that runs across the top of a window which presents word 

processing options organized into a set of Tabs. For each Tab there is a different Ribbon, in 

which you will find Groups of options. 

Ribbons have Tabs; each Tab contains Groups of word processing tools that are closely 

related from the point of view of functionality. For example, in the Home Ribbon (see Figure 

1.5 on page 8 above) you will find the most basic, and therefore the most frequently used 

word processing functions. The Groups in the Home Ribbon also include the tools you 

would tend to use when you first open a Word document and need to set it up with fonts 

and style and spacing and so forth before proceeding to add text. 

These Home Ribbon Groups include the Font Group, which has all the tools you need 

to deal with fonts and text sizes and styles and colors and so forth. Then in the Paragraph 

Group are all the tools for line spacing, text alignment, bullets and numbering, indentation, 

and borders. Next is the Styles Group if you want to use a predefined style layout for your 

document. Finally, in the Home Ribbon you have the Editing Group, which has tools that 

you would be likely to use on an ad hoc basis while developing a document. Also, notice 

the Clipboard Group over to the left of the Home Ribbon, very useful when you are cutting 

and pasting text within a document or from one document to another. 

Many of the tools in the various Office Ribbons can still be accessed using a key 

sequence at the keyboard. Later in these lessons you will be introduced to many of these so-

called Quick Keyboard Commands. For this reason, the author has prepared a Shortcuts 

chart that breaks down the most used Office Word 365 quick keyboard commands. The chart 
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is available as a separate download at the end of the list of contents on the download site for 

these Office 365 tutorials. 

 

1.2 SETTING UP AND NAMING A NEW WORD DOCUMENT 
The Ruler at the top of the page is an essential tool to have on your screen when you are 

word processing. It is in the Ruler that you set tab stops and indent markers (which you are 

going to learn about in this tutorial). If your version of Office Word 365 does not show the 

ruler at the top of the word processing page (see Fig. 1.13), you need to complete a couple 

of steps before proceeding with the tutorial. 

 

Fig. 1.13 Setting (Showing) the Office 365 ruler 

First you need to do the following to have the Ruler bar showing in your Word window. 

Click on the View tab to bring up the View Ribbon (Fig. 1.13 above) 

Now locate the Show Group and click to put a check mark (tick) in the 
box next to Ruler (see again Fig. 1.13 above) 

You may also need to set the line spacing to single spaced before you proceed because 

the default setting on the computer you are using may not be single spaced. Here’s the 

easiest way to do this. 

Click on the Home Ribbon Tab, then in the Styles Group (Fig. 1.14), 
click on the No Spacing tool 

 

Fig. 1.14 The Styles Group > No Spacing tool 

Tool for setting 

Tab Stops 

Indent Markers 

The Ruler 

bar 

Show Group 

No Spacing 

tool 

Styles Group 

Click to put a 

check mark/tick 

in this box 

http://www.pitt.edu/~edindex/Office2016frame.html
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Now you’re ready to proceed with the rest of the tutorial. Fig. 1.13 on the previous page 

illustrates the Ruler Bar, along with the tool for setting tab stops and the tools for setting 

left and right indents—called indent markers. 

Most users of Microsoft Word never figure out how to use these tab stops and indent 

markers; many users do not even know they exist!  By the time you are done with these 

tutorials you should be very familiar with them. 

Check out the tool for setting Tab stops; it’s on the same line as the Ruler 
bar at the left edge (Fig. 1.13 previous page)—it’s so small you could 
easily miss it (and a lot of Word users do!) 

You’ll be practicing using this Tab Stop tool later in the tutorial; make a note of it for 

now. 

Make a mental note of the Indent Markers too; they’re on the left and 
right side of the Ruler bar (Fig. 1.13 again) 

You'll have the opportunity in this lesson to learn how to use each of these essential 

word processing tools. 

Naming and Saving a new Word document 

Look at the new document’s name (it’ll be Document1 or Document2) 

at the top center of the word processor window 

The document is given the default name—Document1 or Document2, etc.—by the 

system because you haven't yet given it a name of your own. 

It is always—ALWAYS—a good idea to thoughtfully name a new document right away, 

before you even enter any data, and save the file/document in the folder, on the drive on 

which you intend to keep it. 

It’s not a bad idea, at the same time, to save a backup copy on another disk drive (though 

you’ll also have the opportunity to create backups at the end of each lesson of these 

tutorials). 

There are three good reasons for naming your files thoughtfully: 

1. You will more easily be able to identify the contents of a document if you give it an 

appropriately descriptive name (such as Letter to Mom 3-8-04). 

2. You will more easily find a document at a later date if you are careful to save it on 

a disk drive and in a location of your choice. 

3. A thoughtful name will also help you find a document you may have misplaced, 

because you can use the name (or a part of the name) to have the system search for 

a file you may have misplaced. 

When you select the Save option, the system will prompt you to identify the location of 

your choice. So, when it does, be sure to select where you want the document to be saved 

(on which disk drive and in which folder on that drive). 

This is easy enough to do. Here are the steps in case you don't already know what to do. 
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From the File menu select Save As 

Word displays the dialog box for the Save As Backstage View (Fig. 1.15). 

 

Fig. 1.15 The Save As dialog box in the Backstage View 

The Save As dialog box prompts you, among other things, 

(1) to select the location or disk drive where you want to save the new document; 

(2) to create or select a folder on that drive in which to save it; 

(3) and once you have selected a place to save your document, you will then be 

prompted to type a name for the document. 

The initial Save As > Backstage View lists locations where your files can be saved (Fig. 

1.15 above). The Cloud (OneDrive) is literally a “farm” of computer storage servers located 

somewhere or other—and it could be anywhere on the planet!  Microsoft, for example, will 

give you up to 7 gigabytes (GB) of memory on its “Cloud” servers for your files. If you 

wanted more than that you would have to start paying for the extra space—or sign up for 

Microsoft 365. 

We will not be using the Cloud in this book, but it is something of which you should be 

aware. Feel free to explore this option on your own at support.microsoft.com. 

For the exercises that follow, you will save all the files you will use for these tutorials 

in the Work Files for Office 365 folder that you unzipped at the start of this lesson. Every 

time you create a new document, you will need to navigate to the location in the Work Files 

for Office 365 folder where you want to save the file. 

Here are the steps to save this first document in the Work Files for Office 365 folder. 

These are 

optional 

locations to Save 

the document 

…or you can Browse to another location on or 

off the computer (This PC, a DVD disc, or a 

USB drive, for example) 

http://www.support.microsoft.com/
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In the Save As dialog box click on the Browse button—This PC is 
already selected by default (Fig. 1.16) 

 

Fig. 1.16 Navigating to the USB drive 

In the Save As dialog box that pops up (Fig. 1.17), in the left hand 
frame locate the Windows (C:) icon, click ONCE on it to open it, then 
navigate to the Work Files for Office 365 > Data Files folder  

  

Fig. 1.17 Locate the Work Files for Office 365 > Data Files folder 

Double click on the Data Files folder to open it 

Click on the 

Browse button 

Double click to open 

the Data Files folder 
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Creating a new folder on a disk 
Inside the Data Files folder you need to create a new folder to store all the documents you 

will create using Microsoft Word. 

Still in the Save As dialog box, click on the New Folder icon (Fig. 1.18) 

  

Fig. 1.18 Creating a New Folder in the Save As dialog box 

The system immediately creates a new folder (Fig. 1.18 above) with a default name 

(New Folder) highlighted in blue, inviting you to rename it by typing a new name of your 

own (Word Documents Fig. 1.19). 

 

Fig. 1.19 Naming the new folder 

No need to delete the default name, just type Word Documents for 
the new folder’s name, hit the Enter key, then double click on the 
folder to Open it 

Click on the New folder icon 

to create a New Folder 
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Word opens the new folder so that you can save the new document inside it (Fig. 1.20). 

In the File name: data entry box (Fig. 1.20), type Conference Call 
Letter to replace the default name and press Enter (or click on the Save 
button) 

  

Fig. 1.20 Naming the Conference Call Letter 

The Save As option thus allows you to name your documents and at the same time 

determine the location (the folder, on a particular disk) on which you want to store them. In 

effect, by naming the document and specifying the location on which it will be stored, you 

are reserving a space for the document on the disk. 

From now on, you do not need to select Save As to save the document unless you want 

to save a backup or save it in some other location. Whenever you simply Save this particular 

file, it will be saved with this name (Conference Call Letter) in this same folder (Word 

Documents) in the Work Files for Office 365 > Data Files folder. Perfect. 

 

1.3 SOME HELPFUL HINTS WHILE USING WORD 365 
You will shortly type the text of the Conference Call Letter. But before you start, take note 

of the helpful hints that follow. 

Word processing is not the same as using a typewriter 

Next to no one uses a typewriter anymore. But if you happen to be one of those who never 

used a computer but you used to use a typewriter, read on. If you never used a typewriter 

before (or perhaps have never even seen one!), skip the rest of this section. 

As you type at the computer keyboard, the letters appear on the screen. When you use a 

typewriter, however, the letters appear directly on the paper. 

Also, when using a typewriter you have to move the carriage back at the end of every 

line so you can start typing at the beginning of the next line on the page. This is called a 

Replace Document1 with the new name 

Conference Call Letter 
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carriage return. When you use a word processor, however, the system takes care of the end 

of each line. As you type in word processing, the program is aware that you are getting to 

the end of the line, and it will automatically move a word to the beginning of the next line 

if it doesn't fit completely on the end of a line. The technical term for this is “wrap around.” 

You don't have to worry about hyphenating words that are broken up over two lines—unless 

you want to, of course. 

So, when you are using a computer, the only time you need to hit the Enter key is at the 

end of a paragraph, whether the paragraph be one word, one line, or several lines. 

Type the following passage so you can practice this now—remember, 
don't press the Enter key until you get to the end of the paragraph, and 
don’t worry if the end of each line on your computer is different than 
shown here1 

And though he tried to look properly severe for his students, Fletcher Seagull suddenly 

saw them all as they really were, just for a moment, and he more than liked, he loved 

what he saw. No limits, Jonathan? he thought, and he smiled. His race to learn had 

begun.2 

Now press Enter at the end of the paragraph 

Notice how the word processor took care of the end of each line. 

There are two cursors you need to know about 

When you are word processing, there are two independent cursors you need to know about. 

One is called the I–beam cursor and the other is called the Insertion point cursor (Fig. 1.21). 

 

Fig. 1.21 The two kinds of cursors 

 
1 The lines on your screen may be longer or shorter. 
2 From the book "Jonathan Livingston Seagull: a story" by Richard Bach. New York, NY: Avon, 1970. And 

yes, the grammar is correct, so don’t worry if it seems odd to you here and there! 



ESSENTIAL MICROSOFT OFFICE 365: Tutorials for Teachers 

Copyright © Bernard John Poole, 2020. All rights reserved. 

 

 18 

The I–beam cursor is so called because it looks a bit like an uppercase "I" and not unlike 

an I-beam used in construction. It becomes an arrow when positioned in the left margin of 

the page or when rolled outside the edges of the page. Try the following for practice. 

Roll the mouse around and notice how the I–beam cursor follows along 
and changes to an arrow pointing to the right each time you cross into 
the left margin, or into an arrow pointing to the left if you slide into the 
top or bottom margins of the page 

The Insertion point cursor (which blinks on and off on the screen and is not directly 

controlled by the mouse) is so called because it indicates exactly where characters will 

appear in the text when you type at the keyboard. 

The I–beam cursor, on the other hand, is under the control of the mouse and allows you, 

by clicking on the left mouse button, to position the insertion point cursor anywhere in the 

text of your document. Practice will help you understand how this works. 

Use the mouse to move the I–beam cursor on the screen so it is 
positioned immediately before the word "Fletcher", then click the left 
mouse button once and roll the mouse away to your right or left 

The insertion point cursor, which originally was positioned at the end of the Livingston 

Seagull quote, should now be blinking on and off right in front of the word "Fletcher." 

Notice how you used the mouse and the I–beam cursor to change the position of the 

insertion point cursor. 

Now position the I–beam cursor immediately before the word "though" 
in the first line and click the left mouse button so as to position the 
insertion point cursor there 

Type the word "even" followed by a space, then click at the end of the 
paragraph (after the final period) 

So much for how to move the cursor from one place to another in your document. This 

takes some getting used to, but the more you practice the more natural it becomes. 

Correcting errors while entering text 

If you see you've made a mistake and you want to fix it before you go on, you can use either 

the Backspace key or the Del(ete) key (Fig 1.22). 

 

Fig. 1.22 The difference between the Backspace and Del(ete) keys 
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The Backspace key removes text that is left of the cursor, while the Del(ete) key removes 

text that is to the right of the cursor. Try the following example using the Backspace key. 

Position the insertion point cursor immediately after the word “even” 

Press the Backspace key 5 times to remove the word “even” (and the 
space before it) 

You can use the Del(ete) key for this purpose, too. 

Hit Ctrl+z to undo what you just did—so the word “even” is restored 

Position the insertion point cursor immediately before the word “even” 
and press the Del(ete) key 5 times to remove the word “even” (and the 
space after it) 

So, the Backspace key works backwards and the Del(ete) key works forwards. After 

you’ve deleted the text, you would use the mouse to click at the point in the document where 

you want to resume typing. 

Removing unwanted Returns (using the Show ¶ option) 

You can have Word show you everywhere in your document that you hit the Enter key 

(which marks the end of paragraphs). The easiest way to do this is to click on the Show ¶ 

icon in the Paragraph Group of the Home Ribbon (Fig. 1.23). 

 

Fig. 1.23 The Show ¶ icon in the Paragraph Group 

Click on the Show ¶ tool now 

The ¶ symbol is the standard mark used by editors to indicate the need for a paragraph 

break in running text. In the Conference Call Letter that you’ll be typing shortly, the ¶ 

symbol, if you have the option turned on, would appear where you hit Enter at the end of 

each paragraph. Another ¶ symbol would appear on an empty line because, strictly speaking, 

the empty line is another paragraph break. 

The Show ¶ tool also puts a dot to show wherever there is a space in the running text. 

This is useful for you to see if, for example, you have typed extra spaces here and there that 

you may want to remove. I’m not sure how useful this particular aspect of the Show ¶ tool 

is, but at least you now know what those dots everywhere are. 

Position the cursor immediately before the sentence that begins “No 
limits, Jonathan?…”, then hit the Enter key twice 

Show ¶ 
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Notice the ¶ symbols that show you where you hit the Enter key—one at the end of the 

previous line, and the other on the empty line ahead of the cursor. 

Now remove the Paragraph marks you just created by pressing the 
Backspace key twice 

Finally, click on the Show ¶ icon in the Paragraph Group of the Home 
Ribbon to turn off the paragraph marks and all the dots between the 
words 

Undoing unintended actions 

If you do something you didn't intend to do, or you made a mistake, you'll select Undo from 

the Quick Access toolbar which is located right above the File menu in the top left corner 

of the Word window (Fig. 1.24). This is a lifesaver that you will use often! 

 

Fig. 1.24 Undo/Redo tools 

Check out this Undo option in the Quick Access toolbar now so you 
can see where to find it 

A quicker way to Undo is to use the shortcut Ctrl+z on your keyboard. You also can 

undo any number of specific recent actions by clicking on the arrow next to the Undo tool 

in the Quick Access toolbar (Fig. 1.25 above), which will drop down a menu or list of the 

various actions you have taken since the last Undo. Be careful when you use this feature, 

however, because if you undo, say, 10 actions, all the actions you did prior to that will also 

be undone! 

So the Undo shortcut is Ctrl+z and the Redo shortcut is Ctrl+y. 

Scrolling through a document 

We need to open a longer document so you can practice different ways of scrolling. 

From the File menu select Open, locate the Work Files for Office 365 
folder and open it, then open the Work Files folder, then in the Practice 
folder, open the document called Term Paper 

Undo/Redo 

tools 

Quick Access 

toolbar 
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With the Term Paper document open on the screen, take a look at the scroll bars. On the 

right of the screen you have a vertical scroll bar and, inside it, the vertical scroll box. At the 

bottom of the screen you have a horizontal scroll bar and horizontal scroll box (Fig. 1.25). 

 

Fig. 1.25 The scroll boxes 

At either end of the scroll bars are arrows pointing in opposite directions (left and right, 

or up and down). As you might expect, clicking on these arrows will scroll a document left 

or right or up and down. Scrolling from left to right or right to left is simpler than scrolling 

Vertical 

scroll bar 

inside the 

vertical 

scroll box 

Horizontal scroll bar 

inside the horizontal 

scroll box 
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up or down, since you only have the width of the page to deal with. But the process is the 

same for scrolling up and down, too. 

Try scrolling now from side to side—left to right and back again—by 
clicking on the scroll arrows to move the scroll box in the horizontal 
scroll bar 

Try scrolling now up and down by clicking on the scroll arrows to move 
the scroll box in the vertical scroll bar 

You can scroll a lot faster by positioning the mouse arrow on the scroll box itself, 

holding down the left mouse button, and dragging the box left or right, up or down, in the 

scroll bars. 

Try this, too 

If you click either side of the scroll box inside the horizontal or vertical scroll bars, this 

causes the document to scroll in jumps from side to side or up and down. 

Try this as well 

You also can scroll and position the cursor very precisely across a line of text, character 

by character, or up and down from line to line, by using the arrow keys on the lower right 

of the keyboard. 

Try this as well 

Finally, yet another vertical scrolling option is available if you have a mouse with a 

rubberized wheel between the buttons, as illustrated in Fig. 1.26. 

 

Fig. 1.26 The scrolling wheel on the mouse 

Try this, too 

When you have finished experimenting with the scroll bars, close (File > 
Close) the Term Paper document 
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Shortcuts (quick keyboard commands) 

The quickest way to save your work is to press Ctrl+s on the keyboard. The Ctrl (Control) 

key is in the lower left corner of the keyboard. Locate it now. You'll be using it a lot as you 

become more familiar with the Office programs. It is always used in combination with one 

or two other keys. Ctrl+s, for example, is executed by holding down the Ctrl key and, while 

holding the Ctrl key down, simultaneously pressing the s key. 

You'll learn more shortcuts as you go along. The author has prepared a chart that breaks 

down the most used Office Word 365 quick keyboard commands. You will find this chart 

handy when you are learning to use the software for the first time. 

The chart is available at the end of the list of contents on the download site for these 

Office 365 tutorials at http://www.pitt.edu/~edindex/Office365frame.html. For ready 

reference, you might want to print out the Quick Keyboards Commands sheet which lists 

the most frequently used Office 365 shortcut keyboard commands. 

Renaming a document 

You will sometimes want to rename a document that you've already saved on your disk. 

One way you can do this from the desktop is by right-clicking on the icon for the document 

you want to rename. Then, from the context menu that pops up whenever you right-click on 

an object on the screen, select the option to Rename…, which highlights the document’s 

name so that you can type a new name for it. 

To rename a document which you already have open in Word, or in any other Office 365 

application, you would choose Save As from the File menu. This will give you the 

opportunity to save the document with a new name of your choice. Bear in mind, though, 

that when you do this, the document with the original name will still be on your disk—a 

second copy, if you like. If you don't want to keep this copy, you should delete it right away 

so as to remove unwanted clutter from your disk drives. 

 

1.4 CREATING AND SAVING A DOCUMENT 
Practice makes perfect 

You still should have open the Conference Call Letter, with the Jonathan Livingstone 

Seagull quote. You need to clear the Seagull quote from the document. 

In the Home Ribbon > Editing Group choose Select > Select All then 
press the Backspace key once to remove the highlighted text from the 
document 

You can also Select All using the Quick Keyboard command Ctrl+a, or you can use the 

mouse (or your finger if you have a touch screen) to drag to highlight the whole paragraph, 

or you can triple click on the paragraph. 

Notice that the Backspace key removes all highlighted text. The Del(ete) key does the 

same. 

Typing the Conference Call letter 

You should now have a blank page with the cursor waiting in the top left corner, ready for 

you to type in the Conference Call Letter. Fig. 1.27 has the full text of the Conference Call 

http://www.pitt.edu/~edindex/Office2010frame.html
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letter. The Figure also shows where all the Paragraph marks (¶) are. This will help you 

remember to hit the Enter key only where necessary, not at the end of every line. 

As you type, Word will automatically warn you of any spelling or grammar errors it 

finds (by underlining them in red or blue on your screen). This will occur as you type the 

contents of Fig. 1.27. Don’t worry about these warnings for now. 

A momentary loss of power is enough for you to lose all your work, so be sure to get 

into the habit of saving frequently with the quick keyboard command Ctrl+s as you go 

along. It takes but a second to lose all your work; and it only takes a second to hit Ctrl+s at 

the end of every paragraph or whenever you switch to another task while at the computer, 

or if you leave the keyboard to do something else. 

 

Fig. 1.27 First version of the Conference Call Letter 
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First, type your name at the top of the letter—immediately above the 
line that reads “Hodge Road Elementary School”—then hit Enter/Return 
to space down one line 

Now go ahead now and type in the text of the Conference Call Letter 
from Fig. 1.27, saving every few lines as you go along (from the File 
menu select Save—or press Ctrl+s) 

Once you have typed in the whole document and saved it, you should go back and 

correct any errors you may have made, and then save the document again. Remember: when 

you save a document with the same name as before, you are replacing the earlier version. 

 

1.5 EDITING AND SIMPLE FORMATTING OF A DOCUMENT 
Now that your letter is saved on disk, you can make any revisions you want. Word 

processing allows you to treat text like modeling clay. You can easily mold your words and 

ideas. You can change margins, put in underlines, italics, boldface, and so forth. You can 

correct errors, move text around, lay it out on the page—all at the touch of a few buttons. In 

the next lesson (Lesson Two) you will have an opportunity to become quite sophisticated in 

this regard. But let's keep it simple for now. Refer back to Fig. 1.27 on the previous page 

while you complete the next few sections of the tutorial. 

Inserting the date 

There is no date on the Conference Call Letter. A letter is incomplete without a date, so 

here are the steps to have Word put today's date in the letter. 

Click to position the cursor right after the postal code in the first address 
at the top of the page, then press Enter 

The cursor should now be waiting at the beginning of the next line. 

In the Insert Ribbon > Text Group click on Date & Time (Fig. 1.28) 

  

Fig. 1.28 Insert the Date immediately after the first address 

Text Group 

Date & Time 

tool 

Position the cursor here 

then press Enter 
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This brings up the Date and Time dialog box (Fig. 1.29). 

  

Fig. 1.29 Date and Time dialog box 

Click on the Long Date format (Fig. 1.30), then click to put a check 
mark/tick in the box next to Update Automatically and click on OK 

You will appreciate the advantage of allowing Word to insert the date automatically 

when you save the letter as a template. Later, any time you use the template, or print another 

Conference Call letter, the date will be adjusted automatically to reflect the current date on 

which you later edit or reprint the document. 

Adding text to an existing document  

You will often want to add text to an existing document—make revisions and so forth; it is 

an activity fundamental to the whole process of writing. On a typewriter, making any kind 

of change to a document is usually messy, at best, and often difficult to do. Using White-

out can be a pain. When you use the word processor, however, editing is a simple task. Let's 

practice now. 

There is no limit to the extra details that could be added to the letter, but for the sake of 

this exercise you will add just one sentence to the next to last paragraph. The new sentence 

will help parents appreciate what Hellen will get out of her experience at the Institute. 

Position the insertion point cursor so it is at the very end of the 
paragraph (the paragraph, not the sentence) which begins "The 
institute has a wonderful reputation..." and ends “…for the program.” 

This the best format for 

the Date in a letter. It’s 

called the Long Date 

and is easier to read 
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Press the space bar twice and type the sentence: 

She would thus have the opportunity to meet and make friends 
with others of her own age and academic ability. 

Read over the sentence you just typed to check for errors. Correct any you may have 

made. Before you go on to the next section you should save what you have done so far. 

Press Ctrl+s to save the changes you have made to the letter 

Removing text 

There are several ways of removing text. In a moment you'll learn how to highlight a block 

of text in order to move or delete larger sections of text. But if all you want to do is remove 

a few words, or a short sentence, the quickest way is to use the Backspace key. 

Practice this now. You are going to remove the second sentence of the second paragraph. 

This second sentence begins "I have attended the facility myself...". 

Position the insertion point cursor so it is in front of the "T" at the 
beginning of the third sentence of the second paragraph—the sentence 
that begins "Hellen would take part ..." 

Press the Backspace key as many times as is necessary until the 
second sentence of this paragraph is removed from the letter (the 
sentence that reads: “I have attended the facility myself and had a splendid 
time. “ 

You'll find the automatic repeat feature of the keyboard, activated by holding down a 

key (such as the Backspace key) will come in handy for a delete operation like this. 

Press Ctrl+s again to save the changes you just made 

Changing text 

It is often necessary to change a word or words here and there in a document. The 

Conference Call Letter overuses the word "program," for example. The word appears once 

in the first paragraph and then is used twice in the final paragraphs. To improve the letter it 

would be better to rewrite the first sentence of the next to last paragraph to read: "The 

Institute has a wonderful reputation for its offerings for both children and adults." 

Here are the steps to follow to carry out this change. 

Place the cursor between the period/full stop and the "s” at the end of 
the first sentence in the second paragraph (right at the end of the word 
"programs" but before the period/full stop) 

Use the Backspace key to remove the text “both children and adult 
programs” 

Make sure there is still a space after the word “for”, then type the phrase 
“its offerings for both children and adults.” 

Another change you need to make is to the telephone number in the first sentence of the 

last paragraph. A common error with numbers is called transposition, where one 
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accidentally reverses the order of digits. The phone number is supposed to be 772–3223, 

not 772-3232. 

Position the cursor at the end of the telephone number, then press the 
Backspace key 2 times, type the digits "23", and again press Ctrl+s 

At this stage your Conference Call Letter should look much like Fig. 1.30. 

 

Fig. 1.30 Intermediate update to the Conference Call letter 
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Selecting (highlighting) a block of text 

Highlighted text is text that stands out from the rest of the document because, in the case of 

Office 365, the background of the highlighted text becomes a block of light blue color (Fig. 

1.31). 

 

Fig. 1.31 Highlighted text 

When you highlight text, you can do things to it (delete it, move it, copy it, change the 

margins set for it, change the font, the text style or color, and so on) without affecting the 

rest of your document. 

You can highlight a single character... 

Use the mouse to position the cursor so it is immediately before the "H" 
in “Hodge" in the address at the top of the letter 

Hold down the left mouse button and keep it down as you carefully drag 
across just the "H" at the beginning of the word so that it becomes 
highlighted 

This latter operation is tricky the first few times you try it. If you drag across more than 

just the "H", keep your finger on the left mouse button and drag back until you have just 

what you want highlighted. 

You can select as much or as little of the text as you want. Remember, you're in control.1 

Let go of the left mouse button when just the "H" is highlighted 

Now click anywhere in the text to remove the highlighting (i.e. to deselect 
the selected text) 

Try this a few times on different letters anywhere in the document 

You can highlight a single word... 

Position the mouse pointer anywhere over the word "Elementary" in the 
first line of the address at the top of the letter and double click the 
left mouse button (or you can drag across the word using the mouse) 

The single word "Elementary" should be highlighted on the screen. 

Click anywhere in the text to remove the highlight 

Try this on a few more words anywhere in the document till you're 
comfortable with the action 

 
1 If you are new to word processing, the secret here is: don't panic! No matter how much you might think to 

the contrary, when you're working with computers you are in control—as long as you know what you're 

doing. The computer is just a dumb machine designed to serve your information processing needs. These 

tutorials will help you make this dumb machine your friend. 
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You can highlight a line of text... 

Click to position the cursor anywhere in the first line of the address at 
the top of the letter, then slide the cursor into the margin to the left of the 
first line of the address (the cursor changes to an arrow pointing in at 
the line) and click on the left mouse button  

There you have it! The whole line is highlighted. 

Click anywhere in the text to remove the highlight 

Try this on a couple of different lines in the document 

You can highlight several selected lines... 

Click to position the cursor anywhere in the first line of the first 
paragraph, then slide the cursor into the margin to the left of the first 
word of the first paragraph (the cursor becomes a white arrow pointing 
in at the line) 

Hold down the left mouse button and drag down to select (highlight) a 
couple of lines, then let go of the left mouse button 

The lines you selected are now highlighted 

Click anywhere in the text to remove the highlight 

You can quickly highlight an entire paragraph... 

Move the I–beam cursor anywhere in the first paragraph, triple click 
(quickly click 3 times) on the left mouse button and notice how this 
highlights the entire paragraph 

Click anywhere in the text to remove the highlighting 

You can highlight an extended area (or block) of text... 

Place the cursor right at the start of the second paragraph 

Now, hold down the Shift key—and keep it down—while you click at the 
end of the paragraph; notice that the whole paragraph is highlighted 

Click anywhere in the text to remove the highlighting 

You can quickly highlight an entire document... 

You should be getting the hang of this highlighting by now. You can drag the mouse to 

highlight several paragraphs or even an entire document of several pages. However, 

dragging through a 50-page document would quickly become tedious. So Word provides a 

short cut to select an entire document. You may recall using this feature earlier in the 

tutorial. 

Press Ctrl+a, then click anywhere in the text to remove the highlighting 
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Changing margins and using the Word Indent Markers 

The letter is nearly ready to be printed. There are just a couple more changes you need to 

make. One style for letter–writing is to indent the first line of every paragraph. Another is 

to position the first address (the address of the sender) so it appears at the top right of the 

first page, instead of on the left. In this case, the closing signature could also be aligned on 

the right side of the page at the end of the letter, as illustrated in Fig. Fig. 1.32). 

 

Fig. 1.32 The final version of the Conference Call Letter 

To carry out these changes you need to learn how to use the indent markers. 
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Using the Indent Markers 

Indent Markers are used to adjust the first line and the left and right margins of paragraphs 

(not individual lines, unless a paragraph only has one line). To use the indent markers, you 

need to have the ruler showing at the top of your document. 

If you do not see the Ruler Bar at the top of the document (see Fig. 1.34 
on the next page), then in the View Ribbon > Show Group click to put 
a check mark/tick next to the Ruler option 

Now, click to put the cursor anywhere within the first paragraph of the 
letter (this tells Word which piece or paragraph of text to reformat) 

Before we go on, remember that the tip of the mouse pointer is the hot spot 

(Fig. 1.33). Moving the small indent markers is a delicate operation; be sure 

to position the very tip of the mouse pointer on an indent marker. 

 

Fig. 1.33 The tip of the mouse pointer is the Hot Spot 

On the left side of the ruler, at the 0" hash mark, you can see the three indent markers 

that set the First Line Indent, the Hanging Indent, and the Left Indent (Fig. 1.34). 

 

Fig. 1.34 The Indent Markers 

These markers move together when you drag the Left Indent marker (the small 

rectangular marker on which the other two triangular markers sit). 
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Let’s practice doing this. 

With the cursor anywhere within the first paragraph of the letter, place 
the tip of the mouse pointer on the Left Indent marker (see Fig. 1.34 
previous page) on which the Hanging Indent marker (the lower of the 
two triangular markers) sits 

Use the mouse to drag the Left Indent marker across ½” to the right 
(to the ½” hash mark on the ruler), then let go of the left mouse button 

Notice that the First Line Indent marker (the upper triangular marker) and the Hanging 

Indent marker (the lower triangular marker) shifted right along with the Left Indent marker 

and that the whole paragraph moved to the right half an inch (½”). 

Now, position the tip of the mouse pointer on the First Line Indent 
marker (the top triangular marker), hold down the left mouse button and 
keep it down as you independently slide it to the left or right (you won't 
be able to drag further left than the left edge of the page) 

To independently move the Hanging Indent marker (the lower of the two triangular 

markers) you just point at it and drag it to the left or right in the same way (again you won't 

be able to drag further left than the left edge of the page). 

Try this now 

The following directions will give you more practice using these indent markers. You 

will be setting the indent markers for all the paragraphs in the body of the letter. 

First, make sure you can see the whole letter in the window, then use the 
mouse to drag all the indent markers so they are at the left margin of 
the page (back at the 0” hash mark on the ruler bar) 

Next, click before the first word of the first paragraph to position the 
insertion point cursor there then, while holding down the Shift key, click 
at the end of the third (last) paragraph (after the words “…from you 
soon.”) 

All three paragraphs of the letter should be highlighted. 

Now, position the tip of the mouse arrow on the First Line Indent 
marker (the triangular indent marker on top of the other markers) and 
slide it to the right to the ½” hash mark on the ruler 

Notice that the left margin of each paragraph (except for the first line) is set at 0” and 

the first line of each paragraph is set at ½". 

  



ESSENTIAL MICROSOFT OFFICE 365: Tutorials for Teachers 

Copyright © Bernard John Poole, 2020. All rights reserved. 

 

 34 

Practice makes perfect 

If this is the first time you've used these markers you may still feel uncomfortable working 

with them, if only because they’re rather small and may be difficult for you to grab with the 

mouse pointer. More practice will cure that. 

Next you are going to move over the left margin for the First Address and the Date at 

the top of the letter, and then the left margin for the sign off at the end of the letter. Follow 

these steps. 

Drag to select (highlight) the First Address and Date lines at the top of 
the letter (the first four lines after your name) 

Point at the Left Indent marker (the small rectangular marker at the 
bottom of the indent markers), hold down the left mouse button and drag 
all the indent markers together over to the 4" hash mark on the ruler 

Let go of the mouse button, then click anywhere in the text to de-select 
the highlighted text 

The address and date should now be lined up on the 4" hash mark. If you weren't 

successful the first time, just go through the steps again until you get the hang of it. 

Next scroll down to the end of the letter if it doesn't all show on your 
screen 

Select the lines that begin: "Sincerely yours," and that conclude with 
"Ms. Mary Prendergast, MSIS" and “Department Chair” (including all 
the blank lines in between) 

With these lines highlighted, again move all the indent markers across 
to the 4" hash mark on the ruler, as you did for the address at the top of 
the page, then press Ctrl+s to save this (almost final) version of the 
document 

 

1.6 CHECKING THE DOCUMENT FOR SPELLING ERRORS 
Microsoft Office 365 comes with a spelling checker. No matter how good you might think 

your spelling is you would do well to take advantage of this fast, effective tool for catching 

spelling errors or typos. 

Encourage your students to use a spelling checker when they are proofing their word 

processed work. The system will highlight any words that it cannot find in its dictionary and 

may make suggestions for words or spellings the student intended. It can thus help your 

students become better spellers and broaden their vocabulary if they are curious enough to 

check out the meanings of the words they may never have come across before. 

However, it cannot spell for them—yet! Nor can it correct errors such as the misuse of 

"to", "too", and "two"! A spelling checker is not an alternative to proofreading. Tell your 

students they should always proofread their work on the printed page (in hard copy form) 

after they have run it through the spelling checker. It also would be a good idea to have 
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students proofread each other’s papers. Assessing a classmate’s work is a valuable 

collaborative learning experience. 

Accessing the spelling checker 

In the Review Ribbon > Proofing Group select Editor to bring up the 
Editor dialog box (Fig. 1.35)—the word “Elementary” has been 
purposely misspelled in the Conference Call Letter 

 

Fig. 1.35 Spelling and Grammar dialog box 

The Microsoft Office Word spelling and grammar checkers are probably already 

working for you if those functions are in automatic mode and if you see strange looking 
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blue underlines and red squiggles under some of the words. If Word highlights a word or 

phrase, this does not necessarily mean there is anything wrong with it. You still have to be 

able to tell if you have made an error and also know how to correct it. Remember, the 

computer is just a dumb machine—it is a tool to assist your intelligence, not replace it! 

If you tell the Spelling Checker to check your document, and it has "No suggestions" 

for a word highlighted, the dialog box gives you the option to have the Spelling Checker 

Ignore (because the word is correct as is); or Ignore All occurrences of the same word in 

your document (because you don’t want the Checker to stop for them again); or Add the 

word to the custom dictionary (so it won’t be flagged in future documents you work on). 

This is generally useful for proper names. 

In the example in Fig. 1.35 above, the word “Elementary” has been mistyped. As you 

can see, the misspelling was picked up by the Spelling Checker and, in the right-hand pane, 

drawn to your attention. To fix the problem, you just click on the Spelling button (Fig. 1.36), 

and Word 365 will show you what the misspelled word is and offer a solution to the problem. 

 

Fig. 1.36 Fixing spelling and other problems in your document 

Go ahead and click on the Spelling button, then click on the correct 
spelling of the word “Elementary” 

Notice that there is another potential problem highlighted by the Editor: The phrase Fifth 

Grade has been underlined in blue. This tells you that this may be a grammar error because 

of the uppercase (capital) letters at the beginning of each word. As it happens, this is not an 

error, so you can click on the Grammar button and tell Word to Ignore once. Feel free to go 

ahead and do this, though it’s not necessary since it only occurs once in the document. 

Click on the Spelling 

button to bring up the 

Spelling dialog 
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At one time or another you will find all these features useful, so you should take the 

time to check them out. For the most part the Spelling Checker is intuitive, and one of the 

best things you can do at this time is take a few minutes to browse through the various 

selections until you get a feel for what the Spelling Checker can do. 

Using the Spelling and Grammar... option in the Tools menu, work your 
way through the Conference Call Letter and correct any spelling or typing 
errors you may have made 

Save your work one last time when you are done (press Ctrl+s) 

In Lesson 2 you will make more extensive use of the Word Spelling Checker. 

 

1.7 PRINTING A FIRST DRAFT OF THE DOCUMENT 
Print Preview–ing your work 

It is always useful to preview your work on screen before sending it to the printer. In Office 

365, you will always be able to preview your work in the Print dialog box before you send 

it to the printer. Let’s see how this works. 

From the File menu select Print (or press Ctrl+p) 

Word will present you with the Print dialog box which will be similar to that shown in 

Fig. 1.37 (though every computer has minor variations when it comes to printing). 

 

Fig. 1.36 Typical Word 365 Print dialog box 
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What kind of printer are you using? 

If you have a laser printer, the quality is always "Best." But if you have a dot matrix, daisy 

wheel, or inkjet printer you can choose the quality of output you require. You select the 

print quality by clicking on the Printer Properties button in the Print dialog box. 

Printing a range of pages 

As regards Page Range, the Print All Pages option is selected by default. The Conference 

Call Letter is only one page long, so you will by default want to print the entire document. 

Should you want to print a subset of the pages of a long document, say from page 3 to page 

6, you would click the Print All Pages option (see Fig. 1.36 above) and enter the page 

numbers of the range of pages in the data entry box (ex. 1,3,5-12). 

Setting the number of copies 

Word also asks you how many copies you want to print. As you can see (Fig. 1.36 above), 

the number 1 is already selected by default, and for a draft copy that is certainly as many as 

you would normally want. 

You are now ready to print the document. 

Click on the Print button in the Print dialog box 

If all is well with your printer connections and so forth, your printer will now go ahead 

and produce a hard copy of your document. 

Removing your document from the printer 

If, as is likely these days, you are using a laser printer or an ink jet printer, removing the 

paper from the printer is simply a matter of picking it out of the paper tray. 

Save the environment 

A useful environmental tip, for your draft copies, is to reuse paper that has one side 

blank. Keep a box near the printer where others who use the printer can deposit used 

paper that is clean on one side. Only use new paper for a final copy of a document. 

Always proofread your writing 

Now you should take the time once again to carefully read over what you have typed. 

If you used the Spell Checker, remember that it will not necessarily pick up all errors. 

If you type "me" when you meant to type "he," the checker won't mind in the least, since 

both words are in the dictionary. As we noted earlier, the golden rule here is: A Spelling 

Checker is only as good as you are! You should never rely blindly on the feedback from the 

Spelling Checker. So always proofread your writing—and tell your students to do the same. 

You might also have your students proofread each other's papers. Let them be teachers, too; 

it's a great way to learn! 

You should also check the overall page layout to see that the document looks good on 

the page. If there are problems, now is the time to fix them. Make all necessary changes on 

the computer and save the document again on your disk drive. 

If all is well, you are ready to go ahead and print the final version, the one that you will 

send in the mail to the parents. Later, in Lesson 6, you will have the opportunity to learn 

how to use Mail Merge to send individualized copies of a letter to a large number of 

addresses. 
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1.8 RUNNING OFF A FINAL COPY 
Follow the steps you learned above to run off a final copy of your document. 

Most printers today will accept single sheets of paper. So, if you wanted to use your 

school's letterhead, this would be no problem. You would, of course, need to remove the 

sender's address from the top of your Conference Call Letter since this address would 

already be included on the letterhead paper. You might also need to select manual feed for 

the printer, depending on the type of printer you are using. 

 

1.9 MAKING A BACKUP COPY OF THE DOCUMENT 
Your last task before completing this session at the computer should be to make a backup 

of your document. Earlier in this lesson you were asked to prepare a backup disk for all your 

work. Now is the time to learn how to make a backup copy of a single document. For the 

sake of convenience, you’ll make the backup in the same folder (the Data Files folder) as 

the rest of the data files you will create using these tutorials. 

The Conference Call Letter is still open in Word 365. It is also saved in your Work Files 

for Office 365 folder since that is where you have been saving it all along. 

From the File menu select Save As and in the Save As dialog box make 
sure the Data Files folder is open, then change the file name to 
Conference Call Letter Backup and click on the Save button 

Wait while the file is being saved, then close Word (File > Close) 

 

LOOKING BACK 
In this tutorial you have learned the basics of the Microsoft Office 365 Word word processor. 

You now know how to enter text, save it, revise it, set margins, check it for spelling, and 

print it on paper in draft, standard, or letter quality. You also learned one way to make a 

backup copy of your documents. 

Many computer users learn no more than has been covered in this lesson. Under–

utilization is a common fact of life for most computer users; they never discover the wide 

range of useful things the computer can help them do. Ideally, however, this tutorial should 

have made you keen to learn more about Word. Remember what you learned in Lesson 1. 

You may need to refer back to some of the details spelled out here when you are using the 

word processor on your own. 

Above all, keep an open mind. It is almost impossible to know everything about the 

computer, so there is always a lot to learn, even when you think you know it all! 

 

LOOKING FORWARD 
This has been a good introduction to the Microsoft Office 365 word processor. However, 

there is still a great deal to learn. Lesson 2 will give you an opportunity to further advance 

your skills. 
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Many of the word processing skills that you have learned will transfer across to other 

word processors. The more you use the computer as a tool for writing, the more natural it 

will become and the more you will improve your writing ability. The ease with which you 

can make changes will have a significant impact on your willingness to generate quality 

written communication. Word processing will have the same effect on your students, so the 

sooner you can get them using the computer for all their writing assignments the better. 

 

SKILL CONSOLIDATION 
Complete these exercises to reinforce what you have learned in Lesson 1. This will help you 

appreciate the usefulness of the word processor for all your writing tasks. 

1. Use Word to write a letter to someone in your family or to a friend using the same layout 

as the Conference Call letter. There must be at least four paragraphs in the body of the 

letter. Print out a draft copy of the story, proofread it, correct any errors, then print out 

a final copy of the story. Hand in both copies to your instructor. 

2. Write a letter to a school district superintendent explaining the details of a field trip that 

you are planning for your class. Print out a draft copy of the story, proofread it, correct 

any errors, then print out a final copy of the story. Hand in both copies to your instructor. 

3. Write a short story of at least four paragraphs using Word. Set the right and left margins 

at 1.5 inches. Print out a draft copy of the story, proofread it, correct any errors, then 

print out a final copy of the story. Hand in both copies to your instructor. 

4. Use Word to type up a paper of your choice. Print out a draft copy of the paper, proofread 

it, correct any errors, and then print out a final copy of the paper. Hand in both copies 

to your instructor. 

5. Using Word, type a paper of at least four paragraphs explaining what you have learned 

so far in tutorial 1. Print out a draft copy of the paper, proofread it, correct any errors, 

and then print out a final copy of the paper. Hand in both copies to your instructor. 

6. Open Word to create a new document. Name the document “A Day at the Beach” and 

type at least four paragraphs on this topic. Practice adding and deleting words, phrases, 

and whole sentences. Print out a draft copy of the paper, proofread it, correct any errors, 

and then print out a final copy of the paper. Hand in both copies to your instructor. 

7. Open the document "Conference Call Letter." Change the date so that it is the current 

date, save the updated document. Remove all the first line indents from the paragraphs. 

Add a paragraph explaining that if Hellen cannot attend the Institute this year, the offer 

will be open again next year. Save the updated document. Print out a draft copy of the 

letter, proofread it, correct any errors, then print out a final copy of the letter. Hand in 

both copies to your instructor. 


